
  

 
 
 



  

 
 
 
 

WARRANTY 
 
Hamar Laser Instruments, Inc. warrants each instrument and other articles of 
equipment manufactured by it to be free from defects in materials and 
workmanship under normal use and service.  Its obligation under this warranty 
are limited to making good at its factory any instrument and other article of 
equipment, which shall, within one year after shipment of each instrument and 
other article of equipment to the original purchaser, be returned intact to Hamar 
with transportation prepaid, and which Hamar’s examination shall disclose to 
Hamar’s satisfaction to have been thus defective. Other than this express 
warranty, Hamar neither assumes, nor authorizes any other persons to assume for 
it, any other liability or obligation in connection with the sale of its products. 
 
This warranty is not applicable to instruments or other articles of equipment 
manufactured by other companies and limited by a warranty extending for less 
than one year. In such an event, the more limited warranty applies to said 
instrument or article of equipment. 
 
This warranty shall not apply to any instrument or other article of equipment 
which shall have been repaired or altered outside the Hamar factory, nor which 
has been subject to misuse, negligence, or use not in accord with instructions 
furnished by the manufacturer. 
 
The software described in this manual is furnished under a license agreement and 
may be used or copied only in accordance with the terms of the agreement.  It is 
against the law to copy the software on any medium for any purpose other than 
the purchaser's personal use. 
 
The information in this manual is subject to change without notice. No part of 
this manual may be reproduced by any means, electronic or mechanical, without 
written permission from Hamar Laser Instruments, Inc. 
 

©  Copyright Hamar Laser Instruments, Incorporated, 2013 
5 Ye Olde Road, Danbury, Connecticut 06810 

 



  

Table of Contents 
 
 
Bore9 Alignment Software for the R-1307 Readout..................................................................................... 1 

Compensating for Mounting Errors .......................................................................................................... 1 
Bore9 Features .......................................................................................................................................... 1 
Preparing for an Alignment ....................................................................................................................... 2 

Hardware Preparation ...................................................................................................................... 2 
The A-516 Self-Centering Target ............................................................................................................. 2 

Setting up the A-516 Target ............................................................................................................. 2 
Connecting to a Computer Interface ......................................................................................................... 4 

Connecting to the A-910-2.4ZB Interface ....................................................................................... 4 
Connecting to the R-358 Computer Interface .................................................................................. 5 

The Model R-1307 Readout ...................................................................................................................... 6 
R-1307+R Control Panel ................................................................................................................. 6 
Pulse/Continuous Modes (L-705 and L-706 Lasers) ....................................................................... 7 
Using TDC/ROT Mode with the R-1307 Readout .......................................................................... 8 
Configuring the R-1307C, R-1307-900/2.4 or R-1307-2.4ZB for a Cabled (Local) Target ......... 10 

Installing the Bore9 Alignment Software ................................................................................................... 12 
System Requirements .............................................................................................................................. 12 
Installing Microsoft .NET Framework 4 ................................................................................................. 13 
Installing Microsoft Access Database Engine ......................................................................................... 14 
Installing Bore9 ....................................................................................................................................... 15 
Terminology and Conventions ................................................................................................................ 15 

What is Bore Plot? ...................................................................................................................................... 16 
Continuous vs. Individual Bores .................................................................................................... 16 
Error Correction: The NORMIN Procedure .................................................................................. 16 
Measuring Alignment and Size ...................................................................................................... 16 

Getting Started with Bore9 ......................................................................................................................... 18 
Creating a New Project File or Opening an Existing Project File .......................................................... 18 
Standard Features of the Bore9 Screens .................................................................................................. 19 

The Menu Bar ................................................................................................................................ 20 
The File Menu ................................................................................................................................ 20 
The Navigate Menu........................................................................................................................ 20 
The Help Menu .............................................................................................................................. 20 
Navigating in Bore9 with the Status Bar ....................................................................................... 21 

Target Setup ............................................................................................................................................ 22 
Preferences .............................................................................................................................................. 24 

Setting up a Bore Alignment Project .......................................................................................................... 27 
Step 1 - Setup .......................................................................................................................................... 27 
Step 2 – Target Mounting Error .............................................................................................................. 30 
Step 3 – Buckin (Laser Setup) ................................................................................................................ 31 

Laser Mounting Options ................................................................................................................ 31 
Internal Mount Laser...................................................................................................................... 32 
Internal Mount Laser Buckin – AOR Procedure ........................................................................... 33 
Rough Laser Buckin Using the Visual Method ............................................................................. 35 
External Mount Laser Procedure ................................................................................................... 37 

Step 4: Record Data ................................................................................................................................ 40 
Taking Data in Step 4 .................................................................................................................... 41 



  

Step 5: Results ......................................................................................................................................... 42 
Generating a Report ................................................................................................................................ 45 

Exporting Alignment Data to Excel Spreadsheets ......................................................................... 47 
Appendix A - The NORMIN Procedure ..................................................................................................... 49 
Appendix B – The A-910 Radio Transceiver/Hub ..................................................................................... 51 

Front Panel Features ...................................................................................................................... 51 
Rear Panel Features ........................................................................................................................ 51 

Using the R-1307 with a Local Target and the A-910 Radio Transceiver .............................................. 52 
Setting the Target Network ID and System ID for the R-1307 Readout ....................................... 52 
Miscellaneous Display Messages................................................................................................... 52 

Appendix C - Agency Certifications ........................................................................................................... 53 
Appendix D – The R-1307 Menu ............................................................................................................... 54 
Appendix E – Using the Zigbee® Radio Utility .......................................................................................... 54 

Pre-installing the Common USB Port Driver (A-910-2.4ZB) ................................................................ 55 
Installing the A-910 Utility Software ...................................................................................................... 55 
Configuring the Hardware and Utility Settings ...................................................................................... 56 
Manually Selecting the COM Port .......................................................................................................... 57 
Setting the Target System ID and Target Network ID ............................................................................ 58 

Setting the System ID .................................................................................................................... 58 
Setting the Target Network ID and System ID for the R-1307 Readout ................................................ 59 

Miscellaneous Display Messages................................................................................................... 59 
Appendix F – Using Discontinued Computer Interfaces ............................................................................ 60 

Connecting to the R-355D Computer Interface (Four-Axis Operation) ................................................. 60 
Connecting to the R-355D Computer Interface (Two-Axis Operation).................................................. 60 
Connecting to the R-355D Computer Interface (One-Axis Operation) .................................................. 61 

Appendix G – Converting X-Y Coordinates to Polar Coordinates in Alignment Reports ......................... 63 



 

 1  

Bore9 Alignment Software for the R-1307 Readout 
 
Bore9 Alignment Software measures and displays the alignment of multiple bores. It measures bore 
straightness (axis centering) and size (diameter) using one of the bores as a reference. Applications 
include turbines, engine blocks, rotary compressors, extruder barrels, gun barrels, hydraulic cylinders and 
printing press bearings. 
 

Compensating for Mounting Errors 
 
Target and laser mounting errors must be compensated for in order to achieve accurate results in bore and 
spindle work. Bore9 uses the NORMIN method developed by Hamar Laser. The NORMIN method is a 
quick and precise way of canceling out these errors and eliminates the need for complicated, expensive 
fixtures. The word NORMIN is a contraction of NORMal-INverted, which briefly describes the method. 
 
One unit (target or laser) is set in the NORMal (cable down) position, and the other rotated 180 degrees to 
the INverted (cable up) position. A set of INverted readings is taken. Then the laser and target are both set 
in the NORMal (cable down) position and the readings are recorded. In some cases, three readings are 
taken: target NORMal and laser INverted, laser NORMal and target INverted, and both units NORMal.  
The readings are then averaged to cancel out both centering and angular mounting errors and provide a 
very accurate result. A detailed description of the NORMIN procedure can be found in Appendix A, 
beginning on Page 46.   
 

Bore9 Features 
 

 Live display 
The plot displays move with each adjustment, allowing the user to see the misalignment and 
correct it easily.  

 
 Offsets 

Bore9 allows the user to develop or enter various offsets or error corrections. The offsets can be 
toggled on and off as required and include the following capabilities: 
 Zero 
 Buckin 
 Manual Offset 
 Align Target 

 
 Save, print and analyze recorded data 
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Preparing for an Alignment 
 
There are several preparations that need to be made before beginning a measurement or alignment proc-
ess. Ensure that accurate records are kept for all procedures.  
 
Hardware Preparation 
 
 Determine what hardware is necessary to perform the alignment, including the laser, target, mounting 

fixtures, readouts or interface, cables, etc. Make a note of the target model number so that the infor-
mation can be entered into the program setup. 

 
 If a test or measurement is expected to take more than 3-4 hours, be sure to connect portable 

computers, interfaces, and other battery-operated devices to their external power supplies. 
 

 Observe safety precautions when setting up hardware.  Lock out machines for stationary procedures.  
If a machine is running, set up barriers and/or warning signs and route all cables away from moving 
parts. Clean and check all equipment, fixtures, and mounting surfaces before beginning any alignment 
process. 

 

The A-516 Self-Centering Target  
 

The A-516 Target is a deep-bore, self-centering target with a 20x20 mm 
PSD (position sensing device). Other targets with a 20x20 mm PSD 
include the T-1218, T-1220 and T-1240.  

The A-516 Target has a built-in adapter hub that uses measuring legs. 
These legs have special roller bearing tips for deep bore alignment 
checks. The target requires a customized set of M-516CL legs for each 
bore ID and an A-516P Quick Connect Insertion Pole with measuring 
tape. 
 
Setting up the A-516 Target 
 

1. Connect the Roller Legs 
 Insert the M-516CL leg into the target, aligning the dowel 

pin in the slot. 
 Tighten the set screw. 

 

 
Figure 2 – Connecting the M-616CL legs to the A-516 Target 

Figure 1 – The A-516 Target 
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2. Attaching the A-516P Pole Assembly 
 Line up the pole assembly to the back 

of the A-516 target and screw in. 
 Tighten the set screw for the A-516P. 
 
 
 

 
 

 
 

 
 

 
Figure 3 – Attaching the A-516P Pole Assembly 

 
3. Attaching the A-516P Pole Extension 
 Push in the tabs to insert the pole 

extension.  
 
 
 
 
 

 
 

Figure 4 – Attaching the A-516P Pole Extension 
 

4. Inserting the A-516 assembly into the 
bore 
 Hold the target by the by the 

extension pole and insert into the 
bore. The target legs will glide in on 
the rollers on the end of the legs. 

 Using the measuring points on the 
extension pole, line up the measuring 
point with edge of bore. 

 
 
 
 
 
 
 
 
 

 
Figure 5 – Inserting the A-516 Target into the bore 
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Connecting to a Computer Interface 
 
Hamar Laser’s computer interfaces couple with a 
portable computer to act as a readout and allow the 
use of the Bore9 program to perform calculations, 
display live laser beam-to-target position infor-
mation, and plot results.   

 
 The R-358 Interface attaches to the computer 

with an RS-232 cable and is powered by a 
lithium ion battery or an AC adapter. The R-358 
is available in both standard (.0001") and high-
resolution (.00001") versions.  
Note: Select R-358SR if using the now- 
discontinued R-355D. See Appendix F on Page 
60 for more information about the R-355D.  

 The wireless A-910 Interface for Hamar 
Laser’s Type II Universal Wireless Targets 
incorporates a built in radio transceiver 
available in 900 MHz or 2.4 GHz. Operating 
through the A-910 Radio Transceiver/Hub, up 
to 99 Type II Targets may be connected as a Target System Group, and up to ten Target System 
Groups consisting of 99 targets per group may be used at one time. The 900MHz model has an indoor 
range of 300 feet (91 meters) and the 2.4 GHz model has an indoor range of 600 feet (1.83 meters). 
Data transmission is 4 mW and 50 mW respectively. See Appendix B on Page 51 for configuration 
instructions.  

 The A-910-2.4ZB Interface is used for up to 99 targets. The A-910ZB is a very small, USB-powered 
2.4GHz radio transceiver that can read up to four targets simultaneously. If you are using the A-910-
2.4ZN Interface, please see Appendix E on Page 55 for configuration instructions.  

 
 
Connecting to the A-910-2.4ZB Interface 
 

1. Plug the A-910-2.4ZB Interface 
into a USB port on the 
computer. 

2. Open the Bore9 Software. 
3. Select the A-910-2.4ZB in the 

Target Setup. 
Note: See Appendix E on Page 
55 for complete installation and 
configuration instructions. 
 

 
 
 
 
 
 

Figure 6 – A-910-2.4ZB Interface
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Connecting to the R-358 Computer Interface 
 
Note: Before using the R-358 Computer Interface, ensure that the battery is fully charged or that the AC 
charger/adapter is plugged in. Make all connections with computer powered off. 
 
1. Connect the target(s) to the INPUT connector on the front of the R-358 Interface.  

The interface can support one 4-axis target. It can also support two 2-axis targets with the use of 
an optional splitter cable.  

 
 

Figure 7 – R-358 Computer Interface Connections 

 
2. Connect the R-358 Interface to the computer.  

Connect the interface to the computer serial port using the standard RS-232 cable provided. The 
connector for the cable is located on the back of the unit and is labeled COMPUTER. 

3. Turn on the computer. 
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The Model R-1307 Readout 
 
The Model R-1307 Readout supports both wireless Unitargets, such as the 
A-1519, or local (cabled) targets. It is available with a radio frequency of 
either 900 MHz or 2.4 GHz ISM band. The R-1307 can be used as the 
primary readout or as an additional readout to copy position data captured 
by another R-1307.    
  
 
 
 
 
 

 
Figure 8 – R-1307 Readout 

R-1307+R Control Panel 
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Pulse/Continuous Modes (L-705 and L-706 Lasers) 
 
The L-705 and L-706 Lasers are now equipped with a PULSE/CONTinuous switch, which manually 
switches the laser beam between Pulsed and Fixed Beam Modes. Pulse Mode automatically removes the 
effects of excess (ambient) background light for the R-1307 readouts, providing a more accurate reading. 
The R-1307 Readout is capable of supporting both Pulse Mode and Continuous Mode as well as storing 
up to nine different target calibration factors for multiple target users. These capabilities must be specified 
when ordering a system. 
 
The chart below indicates the operational modes for Readouts/Computer Interfaces that operate with the 
L-705/L-706 Lasers: 
 

Mode Readouts Computer Interfaces 
Pulse R-1307B-2.4ZB, R-1307BC, R-1307C, R-

1307-900/2.4, R-1307-2.4ZB, R-1307+R 
A-910-900/2.4  

(when used with R-1307-900 or R-1307-2.4) 
A-910-2.4ZB 

CONTinuous R-307, R-307V R-355C(D) or R-358 
  
Notes:  
1. The T-261A and T-266 Targets do not support the Pulsed-Beam Mode and the system purchased is factory-

configured to operate in CONTinuous mode when using these targets.  
2. When using the L-700 Laser with the R-1307 and a 2-Axis Target, the system is factory-configured to operate 

in CONTinuous mode.  
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Using TDC/ROT Mode with the R-1307 Readout 
 
When a target is inserted into 
a bore, the target may rotate. 
This rotation can cause 
accuracy problems, (for 
example, a 5 degree rotation 
with a 1.00 mm vertical 
value will cause up to a 50 
micron error).  
 
To ensure maximum 
accuracy, it is important to 
ensure that the orientation of 
the alignment axes of the A-
516 Self-Centering Target 
(or any other HLI bore 
target) relative to the bore is 
the same throughout the 
data-taking process.  In other 
words, always keep the 
vertical axis oriented to 0 
degrees (12:00).   
 
One way to do this is to use a 
level vial to keep track of the 
target’s rotation orientation 
as it is inserted into the 
barrel.  Another is to use an 
accelerometer inside the 
target housing. This example 
was done with the A-516, where an accelerometer supplies the rotation-axis “levelness” of the target so 
the user can maintain the rotation orientation of the target for each measurement point. The TDC/ROT 
indicator on the R-1307 lights when the target’s vertical axis is at Top Dead Center (TDC).  This indicates 
that the vertical axis is oriented to 12:00 (0 degrees). See Figure 11 for further information. 
 
TDC/ROT Mode Procedure  
1. Insert the A-516 Self-Centering Target into the bore. 
2. Connect the R-1307 Readout and power on. 
3. Press the Down Arrow on the R-1307 to activate TDC/ROT mode (see 

Figure 9).  The H display indicates the rotation levelness of the target and 
the V display indicates the Vertical axis data. 
Note:  Press the Down Arrow again to switch back and forth between the 
level indicator (TDC Mode) and ROT Degrees Mode (see Figure 11).  Press 
the UP Arrow to return it to H&V mode. 
 
 
 
 

Figure 10 – H and V Displays 

Figure 9 – Using the R-1307+R in TDC/ROT Mode 
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4. Slowly rotate the target by pushing and pulling the target and rotating the pole until the H display 

shows the target to be at ± 1 degrees or the TDC indicator displays “0” or “-|” or  “|-“(see the top left 
and second left screens in Figure 11). Take the data point by pressing the spacebar or clicking Record 
in Bore9. 
Note: While the H display indicates the target’s rotation axis data, the alignment data transmitted by 
the R-1307 to the target includes the H axis data. Therefore, it is not necessary to switch back to 
H&V Mode to record the data point.  When recording alignment, always keep the R-1307 in 
TDC/ROT mode.   

5. Repeat Steps 4 and 5 for each data point taken. 
 
The following screens describe how the R-1307+R-2.4ZB Readout displays the rotation angle data for 
both the TDC and ROT modes.   
Note: In general, it is best to keep the rotation angle within +/- 1 degree from zero.  For TDC mode, 
acceptable values are “|-“ , “0” or “-|”.  See the screens below for more information.  
 

 
Figure 11 – R-1307 Readout TDC/ROT Mode   
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Configuring the R-1307C, R-1307-900/2.4 or R-1307-2.4ZB for a Cabled (Local) Target 
 
Note: Shut off power to the readout before connecting or disconnecting a target from the local port. 
 
1. Connect the cabled target to the local port of the readout 
2. Press and hold the MENU button for approximately 2 seconds to enter configuration mode. 
3. Set the Measurement Units 

Press the MENU button until the upper display shows Use the UP and DOWN arrow 
keys to select either for inches or for millimeters. 

4. Set the Dampening Level 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow 
keys to set the number of averages. Adjust this value as required to suit the application. The 
default for this application is 8. For long distance shots, use 16 or 32.  

5. Set the Readout Function to Local Target 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow 
keys to select . 

6. Select the PSD descriptor applicable to your target 
Press the MENU button until the upper display shows , where designates the 
target calibration factor number. There is one calibration record for each target purchased. The R-
1307 can store up to 9 records.  Each calibration record in the R-1307 has the following target 
types:   
 TGT=0 (for HLI use only. Do not use ) 
 TGT = nn, P.10.10 (10x10 mm sensor-  pulsed beam mode) 
 TGT = nn, F.10.10 (10x10 mm sensor- fixed beam mode) 
 TGT = nn, P.4.4 (4x4 mm sensor- pulsed beam mode) 
 TGT = nn, F.4.4 (4x4 mm sensor- fixed beam mode) 
 TGT = nn, P.20.20 (20x20 mm sensor- pulsed beam mode) 
 TGT = nn, F.20.20 (20x20 mm sensor- fixed beam mode) 
 TGT = nn, P.40.40 (40x40 mm sensor- pulsed beam mode) 
 TGT = nn, F.40.40 (40x40 mm sensor- fixed beam mode) 

nn= R-1037 Readout number and matching target number 
 
Press the UP or DOWN arrow to select the correct target number, which will change the second window. 
For example,  or  for R-1307 #2. The PSD sensor size and type is 
fixed to the target calibration record. 
 
Warning: Targets are matched to specific calibration records in the R-1307 Readouts. For example, 
Target #1 must be connected to Calibration Record #1 in the R-1307 or the calibration is void. 
However, each R-1307 can have up to 9 target records, so up to 9 different target calibration 
records can be stored in each R-1307.  When there are multiple calibration records, the record ID 
must match the target ID, so if you have Target #1, you should select TGT=01 to select the 
matching calibration factors. 
 
7. To exit configuration mode, press and hold the MENU button for approximately three 

seconds until the display returns to normal mode.  
The R-1307 will also return to normal mode automatically after approximately four seconds of 
inactivity.  
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Installing the Bore9 Alignment Software 
 

System Requirements 
1Ghz minimum, 1G RAM minimum (2G RAM recommended), 1.1G free disk space, Screen Resolution 
1024x768 minimum. 
 
The following Microsoft Windows® operating systems have been tested with Bore9: 
Windows XP Professional 2002 SP3, Microsoft Vista Business SP1, Windows 7 Ultimate x64, Windows 
7 Home Premium SP1. 
 
The following Microsoft Windows operating systems have not been tested with Bore9: 
Windows 7 Ultimate x86, Windows 7 Ultimate N, Windows 7 Enterprise x86, Windows 7 Enterprise N 
Windows 7 Enterprise x64, Windows 7 Professional x86, Windows 7 Professional N, Windows 7 
Professional x64, Windows 7 Home Premium x86, Windows 7 Home Premium N, Windows 7 Home 
Premium x64, Windows Vista Ultimate, Windows Vista Enterprise, Windows Vista Enterprise x64 
Edition, Windows Vista Home Premium, Windows Vista Home Premium x64 Edition, Windows XP 
Professional x64 Edition 
 
The following Microsoft Windows operating systems are not recommended for use with Bore9: 
Windows7 Home Basic x86, Windows 7 Home Basic N, Windows Vista Home Basic, Windows XP 
Home Edition  
 
Before installing the Bore9 software, ensure that your computer has the latest Windows Service Pack and 
critical updates. To find security updates, visit www.windowupdates.com. If you are installing on 
Windows XP 64 bit or Windows 2003 you might need to install the Windows Imaging Component.  
The Windows Imaging Component 32-bit can be found at:  
http://www.microsoft.com/en-us/download/details.aspx?id=32.  
The Windows Imaging Component 64-bit can be found at: 
http://www.microsoft.com/en-us/download/details.aspx?id-1385. 
 
In addition, software for reading .pdf files, such as Adobe Acrobat, is necessary in order to access the 
program documentation and read alignment files saved in this format.  
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Installing Microsoft .NET Framework 4 
You must have Microsoft .NET Framework installed before installing the Bore9 software. If you are 
unsure about whether you have Microsoft .NET Framework 4 installed on your computer, open the 
Control Panel. For Windows XP users, select Add/Remove Programs; for Window 7 users, select 
Programs and Features. Scroll down the list of installed software to locate Microsoft .NET Framework 
4.  If the program is not installed, follow the instructions for installation on Page 13. 
 

 
 
 
1. To install Microsoft .NET Framework 4, locate the folder 

MS_Framework_4_X86_X64 on the Bore9 installation 
CD. Open the folder and double-click 
DOTNETFX40_FULL_X86_X64 to begin the 
installation.  Follow the on-screen prompts to complete.  

 
 
 
 
 
 
 
 
 
2. When the installation is complete, click Finish to close 

the installation program.  
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Installing Microsoft Access Database Engine 
The Microsoft Access Database Engine must be installed on your computer before installing the Bore9 
software. This file is usually present if you have a full version of Microsoft Office installed. If not, do the 
following: 
 
1. Open the folder on the Bore9 installation CD 

called MSAccessDatabaseEngine. Double-
click the file AccessDatabaseEngine to begin 
the installation. 

 
 
 
 
 
 
 
 
 
 
 
 
2. When prompted, check the box to accept the 

terms in the License Agreement and select Next 
to continue. 
 
 
 
 
 
 
 
 
 
 
 

3. Choose the location to install Microsoft Office 
Access Database. The default location is 
automatically selected. To change the 
installation location, select Browse and specify 
a folder. Select Install to continue. 
 

4. When installation is complete, click Finish. 
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Installing Bore9  
 
1. Insert the program CD in the appropriate drive.  
2. Click Start and select Run. 
3. Type Drive letter:/Setup, where Drive letter is the location of your CD ROM drive.  
4. Follow the instructions on your screen. 
 

 
 

Terminology and Conventions 
 
This section is designed to introduce the actions used to select features and tasks while using the Bore9 
software. For further information about the Windows interface, see the manual for your operating system.  
 
The following terminology and conventions are used frequently in this book: 
 
• Click = click once with the left mouse button 
• Double click = click twice with the left mouse button 
• Keyboard shortcuts 

 The Alt key can be used in combination with an underlined character to quickly access a 
screen or select a menu item. For example, pressing Alt-H while working in Setup displays 
information for the Help Screen.   

• The names of buttons in the Bore9 program are referred to in bold type: for example, OK. 
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What is Bore Plot? 
 
Bore Plot measures and displays the alignment of multiple bores. It measures bore straightness (axis 
centering) and size (diameter) using one of the bores as a reference. Applications include turbines, engine 
blocks, rotary compressors, extruder barrels, gun barrels, hydraulic cylinders and printing press bearings. 
 
Continuous vs. Individual Bores 
 
Continuous bores, such as rifle barrels, are single bores whose 
lengths are comparatively greater than their diameters. 
Measurements are taken by selecting points along the length of 
the continuous bore and taking readings at these cross sections. 
 
Individual bores, such as bearing mounts in an engine block, are 
separate from one another and usually have lengths which are 
comparatively shorter than their diameters.  One reading is 
taken at the center of each bore.  If the bore is very narrow, the 
target may need to be mounted to a face and centered. 
 
 
Error Correction: The NORMIN Procedure 
 
In order to get accurate results, target mounting and other errors must be compensated for in some 
fashion. The NORMIN Procedure was developed as a way of canceling out these errors.  It is used in 
conjunction with simple fixtures and targets which allow inexpensive, precision measurement. For an in-
depth discussion of the NORMIN Procedure, see Appendix A beginning on Page 46.  
 
 
Measuring Alignment and Size 
 
 To measure alignment of several bores, the laser should be bucked into (made parallel to) the two end 

bores. The target is then moved from bore to bore, and the deviation from the end bores is the 
measure of the misalignment of the bore. For the most accurate results, the same target should be used 
for all of the bores. 

 
Note:  The NORMIN procedure is necessary when performing bore measurement with any target. 
The NORMIN procedure is necessary for performing bore alignment with all bore targets except the 
A-510, A-512 and A-516 Self-Centering Targets.  

 
 To measure the sizes of several bores with respect to a reference bore, a reference bore with a known 

size is selected.  The same target is moved from bore to bore (taking care to square up the target as 
closely as possible), taking error correction readings.  The program calculates and displays the actual 
diameters of the individual bores. 

 
The following are the steps common to the different types of bore measurement: 
 
Hardware Setup 
There are two ways of setting up Hamar Laser’s bore alignment lasers: 
1. External Mount - This method uses the L-111 Laser Stand and the L-102 Beam Translator to mount 

the laser outside the end bores.  A target is moved from the near to far bores and the Buckin 
procedure is used to align the laser to the end bores.   

2. Internal Mount - This method uses the L-708 Laser with the A-514 Self-Centering Bore Adapters to 
mount the laser in first end bore. The A-512 Target and a second A-514 Self-Centering Adapter is 
mounted in the second end bore.  The laser is then tilted (steered) until the readout shows zero.   
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Bucking In 
The Buckin procedure is needed to align the laser to bore reference points (or a spindle axis of rotation) 
so the alignment of other bores can be checked. The laser is positioned by adjusting the laser beam (using 
a beam translator) to center on the near target, and then adjusting the laser itself to point the beam on the 
target in the far position. This is repeated until the target gives the same reading in both positions. 
 
Bore Setup  
The user enters information In the Bore9 Setup Screen, such as the number of and distance between 
bores, the diameter of the reference bore, and the spacing between points to be measured.    
 
Recording Data 
The user moves the target from bore to bore, taking data. Data may be taken in any order desired, but the 
simplest way is to measure bores in numerical order). When taking NORMIN readings to cancel out 
errors, both the NORMal and INverted readings can be taken for one bore before moving to the next or 
the NORMal readings can be taken for each bore in one pass, and the INverted readings in the next.    
 
Plotting Results 
The resulting data is displayed on the screen as a two-view graph.  
 
Saving, Printing, and Reviewing Results 
Data may be saved and customized for review and for generating a printed report.  
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Getting Started with Bore9  
 
To begin using Bore9, double click the Bore9 icon or select the program from the Windows Start Menu. 
The initialization screen displays, providing the number of the current software version.  
 
 

Creating a New Project File or Opening an 
Existing Project File 

 
When the Bore9 software opens, the Project Selection screen 
displays. Here you can either open a saved project or create a new 
project. This screen can also be accessed by clicking Open Project 
from the File Menu.  
 
 
 
 
 
 
 
 
To create a new project, click New Project and enter a 
project name.  
 
 
 
 
To open a saved project file, click Open Project from the File 
menu.  Double-click on the project folder and then click on the 
*.prj file to open the project. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12 – The File Menu  



 

 19  

 

Standard Features of the Bore9 Screens 
 
Bore9 is structured to guide the user through the setup and data taking process.  There are 5 steps to 
collecting bore straightness data: 
 
Step 1 – Bore Setup – enter setup information for the alignment check such as number of bores, distance 
between bore, bore diameters and bore straightness tolerances. 
 
Step 2 - Target Mounting Error - Here an easy procedure is followed to remove the mounting errors of 
the target if desired. 
 
Step 3 – Laser Setup – Here on-screen instructions guide the user through setting up the laser and 
making it parallel to reference points. 
 
Step 4 – Record Data – Here is where the bore straightness data is recorded.  There are several different 
sets of data that can be taken here. 
 
Step 5 –Results – Here the results of the data are plotted on a graph and a least-squares, best-fit data 
algorithm is applied to generate the straightness results and to determine if they are in or out of tolerance.  
Reports are also generated in this step. 
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The Menu Bar 
 
The Menu Bar in the Bore9 program is located at the top of the screen under the program banner. The 
options are File, Navigate, and Help (Alt-H). Click with the mouse on one of these options to see the 
associated drop-down menu. 
 

 
 
Figure 13 – Bore9 Menu Bar 

 
Once a Menu Bar dropdown menu opens, you can access any item on the 
menu by clicking it once with the mouse.  
 
The File Menu 
 
Open Project  Opens folder for user to select project to open. 
Close Project  Closes currently open project. 
Save Project  Saves current project. 
Print Report  View and print current project. 
Preferences Contains Tabs for user to enter Company information, 

Units, Data Grid Displays, Decimal Displays, Target Setup 
and Record Mode. 

Comm Port  Select the COM port that the computer interface is assigned to. 
Exit Bore9 Stores all current settings, prompts the user to save any unsaved data, and exits the Read8 

program.  
 
 
The Navigate Menu 

 
Bore Setup Displays the Bore Setup 

screen (Step 1). 
 

Mounting Error Displays the Target 
Mounting Error screen 
(Step 2). 
 

Buckin  Displays the Laser 
Buckin screen (Step 3). 

Record Data Displays the Record 
Data screen (Step 4). 

Results Displays the Results 
screen (Step 5). 

 
The Help Menu 
 
User Guide Displays the User’s Guide. 
About  Displays the software information.  
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Navigating in Bore9 with the Status Bar 
 

Click any number on the Status Bar to navigate to that step in the software.  The right arrow and left 
arrow advances to the next screen. 

 

 
 
Notes - Click Notes in the Status Bar to open a place to enter notes for the alignment.  This information is 
printed in the report. 
 
Units – displays the measurement units 
selected in Preferences. 
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Target Setup 
 
When you buy a new system from HLI, 
your target setup should already be pre-
configured into Bore9. If so, then please 
go to Step 1— Setup on Page 27 to 
select the target.  
 
If the target setup data has not been 
entered, click File>Preferences>Target 
Setup. Click New Target to specify and 
set up a computer interface and to select 
a target that reflects the type of work 
being performed. 
 
 
 
 

 
1. Select the type of Computer Interface you are using 

and click Next.  
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Select the target you are using and click Next. Hover the  mouse 
cursor over a picture of a device to enlarge the picture.   
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3. A popup displays asking you if you want to load 

calibration factors.  If you have a disc with your 
Target File, you may load it now. Click Yes to 
load your configuration files. Select No to 
continue if you do not have a Target Files.   

 
 
 
 

4. If you clicked No, enter the required infor-
mation: Target Name, Calibration Date, Target 
Network ID, (see Setting the Target System ID 
and Target Network ID on Page 58) and de-
pending on your target, the Calibration 
Constants. The Serial Number, Focal Length and 
Description are optional. Note that the Name 
field can contain any name that will readily 
identify the target.  

 
 
 
 
 
 
 
When using cabled targets, the Target 
Network ID field is replaced with DC Plane. 

 
 
 
 
 
 
 
 
 
 
 
 

5. Select Finish. The target displays in the drop-down menu in the Select Targets to Use on Page 27.   
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Preferences  
 
Note:  Please note the Global and Project tabs at the 
bottom of the Preferences screen. Any changes made when 
selecting Global affect the entire program.  If a project file 
is opened with different preference settings, these setting 
can be changed by clicking Project and changing the 
preferences to those of that project.  
 
Calibration Constants 
 
Click Load Target File… to load the calibrations 
constants for the target specified in the Target Setup.  
These files are found either on the CD that is sent 
with a target or in a folder where they’ve been 
copied to your hard drive. When entering the 
calibration constants from a printed list, click on 
each field and enter the value manually.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Decimal Display Tab – Select the 
desired number of decimal points to be 
used for alignment data displays.   
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Company Information Tab – Enter company 
contact information for the reports here.  If you 
click Include Logo in Reports and then click 
Browse, you can import a company logo to 
display on the report.   
 
 
 
 
 
 
 
 
 
 
Data Grid Display Tab – This tab includes 
several options that control how Bore9 takes 
data and what analysis data is displayed in Step 
4– Take Data. For most standard bore 
straightness applications using HLI’s self-
centering targets, click Select Standard 
Display. This will pre-select the data taking 
method of Normal Target Reading – Center 
and Reference Target. 
 
When using non-self-centering bore targets or 
to calculate bore diameter changes, select 
Inverted Target Readings – Center, CE – 
Centering Error – Center (N-I)/2, Diameter 
and TCE – Target Centering Error – Center 
(N-I)/2.  In this case, you will be required take 
a NORMal and INverted reading at each bore 
location.  This allows the software to remove 
any mounting errors (TCE) in the fixturing and 
also calculate the bore diameter change (if a 
reference bore diameter was entered in Step 1 – 
Setup on Page 27). 
 
Units Tab – Use this tab to select Imperial 
(inches) or Metric (mm) and units for any slope 
calculations. Slopes in Degrees format display 
as a decimal number (for example, .012 
degrees). Seconds format display in arc seconds 
(for example, 1.45 arc secs). 
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Record Mode Tab – Select the number of data 
samples for each data point, as well as a date 
and time stamp and comment for each data 
point.  
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Setting up a Bore Alignment Project 
 

Step 1 - Setup 
 
Enter the setup information for the bore alignment project, such as number of bores, distance between 
bores, targets being used, tolerances, etc. 
 

  
 
 
 
Select Target to Use – Select the target(s) to be used in the alignment setup. If the target you are using is 
not in the dropdown list, go to Preferences>Target Setup to add your target (see Target Setup on Page 
22). 
 

  
 
Number of Targets – For most bore applications, you will use only one target, so select a specific target 
by clicking the dropdown list for Target A. For two-target bore applications, also select a specific target 
for Target B. 
Note: You cannot select the same specific target for the A and B targets. 

 
Figure 14 – Initial Bore Plot screen with Bore Setup 
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Bore Spacing – Specify whether the bores to be measured are evenly or unevenly spaced. If they are 
evenly spaced, enter the common distance between points and the starting value. If they are unevenly 
spaced, select the Uneven Bore Spacing Tab and enter the distance between individual points in the grid.  
 

 
 
Number of Bores – Enter the number of points to be measured, either by typing in the number or using 
the up and down arrows. A minimum of three and a maximum of 50 points can be specified. 
 
 
Reference Bore Diameters – If measuring several bores with respect 
to a reference bore, select the number of the bore to designate as a 
reference and supply its vertical and horizontal diameter. 

 
 
 
 
 
 
 
 
 
 
 
Laser Position – Click on the graphic to select direction the laser is 
facing (left or right). 
 
 
 
 
 
 
 
 
 
 
Tolerance Bands – When the Tolerance Bands feature is ON and a 
tolerance number is assigned, the graphs in Step 4 will indicate whether 
the overall straightness (the acceptable straightness misalignment 
tolerance over the whole range of data points) and bore-to-bore 
straightness data is within the values specified.  
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Bore To Bore – The acceptable deviation tolerance from one bore to the next.   
 
When viewing the alignment graphs in Step 5, there will be a green tolerance band to indicate the overall 
bore straightness tolerance.  If a data point falls outside of this area, it is out of overall tolerance.  For 
bore-to-bore tolerance, a red dotted line between measurement points indicates an out-of-tolerance 
condition between those points.   
 
Reference Target – A tolerance for the reference target when taking data in Step 4 using two targets, 
where one target (reference) is used to monitor laser drift.  If the display values exceed the tolerance 
entered here, the Reference Target display turns red.  
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Step 2 – Target Mounting Error 
 
The Target Mounting Error uses NORMIN readings to determine mounting and other errors in a fixture-
mounted target and adjusts the display to remove the error from the readings. The user will be required to 
take 2 data points:  1) with the target in the NORMal position; and 2) with the target in the INverted 
position.  The software calculates the mounting error and then applies it to the displayed and recorded 
data to remove the mounting error from all data points.  This is a global target offset and is applied to all 
data unless it is turned off.   
 
1. Coarse-align the laser and target on the numerical display. 

Ensure that that laser and target are in position and the numerical display is showing readings.  
 
2. Select TNID (Target Network ID). 

Using the drop-down arrow, select the TNID for the target you are 
using to perform the mounting error.  
 
 
 

 
3. Click Start. The graphic showing the target with an I displays the 

proper orientation of the laser and target for taking the first reading. 
Invert the target so the cable is at 12:00. 

 
4. Click Record to take a reading.  

Ensure the target and fixture or bore adapter have 
been rotate to the INverted position. Click Record 
or press the spacebar to take a reading at the current 
position of the target and laser. Wait until the 
program takes all of its samples and displays the readings before performing the next step. The 
cursor moves automatically to the next field in the table and the graphic showing the laser and 
target orientation changes.  

 
5. Return the target to the NORMal position. 

Rotate the target to NORMal position and level. (The target graphic 
now shows the letter N). 

 
6. Click Record to take a reading.  

Press Record or press the spacebar to take a 
reading at the current position of the target and 
laser. Wait until the program takes all of its samples 
and displays the readings before performing the 
next step. Bore9 automatically calculates the 
mounting error offsets and applies them to the 
displayed reading.  You will see the Offsets button 
show ON, indicating there are offsets being 
applied.   

  
The plot screen now reads the laser beam misalignment (less fixture mounting errors). The Offset 
button and Status Bar indicate that Target Mounting Error offsets are ON. Any further readings 
display with this value subtracted. 
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Step 3 – Buckin (Laser Setup) 
 
Buckin (laser setup) calculates set points for making a laser parallel to two reference points, usually the 
end bores.  Use the Step 3 Buckin Wizard to guide you through the Buckin process. 
 
While performing Step 3 – Buckin, the following options are available: 
 

 
 
Restart – click to restart the Laser Buckin procedure. 
Record – click when instructed to record data for laser setup. 
Previous – click to return to the previous steps of the procedure. 
Next – click to proceed to the next set of steps in the procedure. 
Finished – Next becomes Finished when the last steps of the procedure display.  Click Finished to 
proceed to Step 4—Record Data. 
 
Laser Mounting Options 
 
There are two ways to set up the laser: 1) Internal Mount or 2) External Mount. Select Internal Mount if 
using the L-708 Laser with the A-514 Self-Centering Adapters or if using any bore laser mounted directly 
in a spindle. Select External Mount if using the L-705/L-706/L-708 with the L-111 Laser Stand and L-
102 Beam Translator.  
 

 
 
Figure 15 – Bore Setup Display showing Internal Mount 

 

 
Figure 16 – Bore Setup Display showing External Mount 
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Internal Mount Laser 
1. Select the laser mounting by clicking the Internal Mount graphic. Click 

Next.  
2. Select the target to use for the laser setup. If using one target, select 

Target A for the laser setup. If you have two targets, select Target A or 
Target B for the laser setup.  Click Next. 

 
Note: For internal mount, you cannot choose A+B.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Follow the on-screen instructions to perform the laser setup.  

 
 

4. Click Finish to go to Step 4—Record Data. 
 
 

 

Target A Selected Target B Selected 
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Internal Mount Laser Buckin – AOR Procedure 
 

For applications such as extruder barrel alignment or spindle to bore alignment, the laser setup procedure 
is slightly different than the External or Internal Mount laser setups.  The main difference is the laser 
needs to be adjusted so that it is parallel and co-linear to the Axis of Rotation (AOR) of a spindle.  For 
this procedure, you will be using the live display to calculate a set of Set Points to steer the laser to make 
it co-linear to the spindle’s AOR.   
 

 
 

Laser Buckin AOR Procedure 
Insert L-705/706/708 laser into spindle fixture 
and set the micrometers to the Nominal Settings.  
Turn on the laser to either Pulsed Mode 
(standard) or Continuous Mode (legacy). 
1. Rotate the laser to the INverted position 

(Vertical Arrow pointed at 6:00) until the 
bubble is centered in the level vial window. 
Note:  There is a bubble vial on both the 
top (NORMal) and bottom (INverted) of the 
laser. 

2. Insert the target and bore adapter into the far 
bore location. 

3. Ensure the laser is hitting the target.  If not, 
then use Rough Laser Buckin Using the 
Visual Method described on Page 35 to 
visually buck in the laser. 

4. Connect the R-1307 Readout (or R-358) and turn it on, making sure to match the laser mode (Pulsed 
or Continuous) in Step 1.  See Page 7 for more details on changing the laser mode in the R-1307. 
Insert A-910-2.4ZB Radio Receiver into the USB port on the computer. 

5. Open Bore9 and follow the steps in this manual (see Page 10) to configure the target to the readout so 
that the displays are showing live data.  
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6. Write down the V and H values for the INverted Position.  
7. Rotate the spindle (holding the laser) 180 degrees to the NORMal position until the bubble is 

centered in the level vial window.  Write down the V and H values. 
8. Find the sum of the readings and divide by 2 (the number of readings) to calculate the laser Set 

Points. 
 

(Normal reading + Inverted reading)  

2 
  

Calculations for vertical and horizontal readings must be done separately. The formulas for 
vertical and horizontal set points are: 

 
(Normal V + Inverted V)    =    V SET POINT 

         2  
(Normal H + Inverted H)    =    H SET POINT 

                  2 
 

Example of calculating the Vertical Set Point. 
.  

VN = -.016 
VI = +.008 
  -.008 
Divide by 2 

 V Set Point =  -.004 

VN = -.016 
VI = -.008 
  -.024 
Divide by 2 

 V Set Point =  -.012 
 

9. Turn the V & H micrometers (adjustment knobs on the L-708) until the V display value equals 
the V Set Point and the H display value equals the H Set Point. 

10. Rotate the laser to the INverted position.   
11. The V and H values should be the same as when the laser is in the NORMal position.  If not, then 

repeat Steps 7 thru 11 until the values are the same within your desired tolerance.   
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Rough Laser Buckin Using the Visual Method 
 
Note:  This procedure is performed without the target inserted in the barrel. 
 
1. Cover the far end of the barrel with white paper.  

Using a compass, draw a circle the same size as the bore diameter on a piece of white paper.  Mark 
the center of the circle.  Tape the paper to the far end of the barrel. The laser beam must be visible 
through the paper.  
Note:  Another way to make a circle in the paper is to lightly press the paper at the edge of the barrel 
and trace your fingers around the inside edge of the bore.  This will create a round crease showing 
the ID of the barrel.  Take a ruler to find the approximate center of the barrel and mark it with a 
pen/pencil. 

2. Mark the laser beam location on the paper.  
Set the laser to Continuous Mode (see Page 7).  With the laser placed in the NORMal (upright) 
position, draw a small circle where the laser beam hits the paper.     

3. Invert the laser, spindle adapter and the spindle AS A UNIT and mark the laser beam location 
on the paper. 
Using the bubble levels as a reference, rotate the spindle, laser, and adapter as one unit a total of 180 
degrees until the level bubble on bottom of the laser is on top and centered. Now draw a small circle 
where the laser beam hits the paper. 
Note: The laser, adapter, and spindle must be rotated AS ONE UNIT. Do not rotate the laser by 
itself. Also make sure that the circular level bubble is centered, or the results will not be accurate. 

4. Measure to find the Visual Set Point and adjust the laser beam.   
Using a ruler, measure the distance between the centers of both circles and mark the halfway point 
(see illustrations below) on the paper. This is the Visual Set Point. Turn the vertical and horizontal 
micrometers until the laser beam is centered on the Visual Set Point mark.   
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5. Invert (rotate) the laser, spindle adapter and spindle AS A UNIT to ensure that the laser beam 

remains at the Visual Set Point.    
Following the instructions in Step 3, invert (rotate) the laser, spindle adapter and spindle AS A UNIT 
to ensure that the laser beam is still centered on the set point mark. If not, repeat Steps 2 thru 5 until 
the laser stays centered on the Visual Set Point. 

6. Measure the distance from the Visual Set Point to the mark at the center of the bore.   
If the distance from the set point to the mark at the center of the circle is 0.4” (10 mm) or greater, 
move/align the end of the barrel until the center mark lines up with the Visual Set Point mark (see 
illustrations below).  This is called a rough alignment. 

7. Complete the setup procedures.  
Remove the paper and insert the target in the barrel, as described on Page 32. Then follow the Laser 
Buckin procedure. 
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External Mount Laser Procedure 
1. Select the laser mounting by clicking the External Mount graphic. 

Click Next.  
2. Select the target to use for the laser setup. If using one target, select 

Target A for the laser setup. If you have two targets, select Target A 
or Target B for the laser setup.  Click Next. 
 
 
 
 

 
3. Enter distances as described. For example: 
 

Distance from Laser Pivot to Near Target D1 = 4.46 
Distance from Near Target to Far Target D2 = 12.67 

 

 
 
4. Follow the on-screen instructions to record data for Near Point and click Next. 
 
 
 

1.  
2.  

 
3.  

 
4.  
5.  
6.  
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Data for the Near Target are displayed in Results and highlighted by a green background. 
 

 
 
5. Follow the on-screen instructions to take data for the Far Target and click Next. 
 

 
 

Data for the Far Target are displayed in Results and highlighted by a green background. 
 

 
 
 
6. After clicking Next, the Laser Set Points are calculated and highlighted in yellow in Results.   
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7. Follow the on-screen instructions to steer the laser beam so that the display matches the Set 
Points.   

 
 

 
 
8. If the display does not show zero after moving the target back to the Near Bore, repeat the above 

steps until the target displays zero in both the near and far bore locations.   
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Step 4: Record Data 
 
Once the laser is bucked in, begin taking data.  
 

 
 
Figure 17 – Record Data screen 

 
Auto Step – Auto Step automatically moves from one point to the next, either in NORMal Mode, 
INverted Mode, or in both modes. Check the box marked Auto Step to toggle the Auto Step feature on 
and off. When Auto Step is ON, the cursor automatically advances to the next position when data is 
recorded. When Auto Step is OFF, data records at the same position and overwrites the previous data 
recording. Disabling Auto Step allows the user to move the target to a point where data has previously 
been recorded, select that point on the plot and retake the reading.  
 

 
 
Direction – To change the direction to record data, click the left or right Direction arrow in the Auto 
Step area of the screen. 
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The Target Orientation, Measure Target and Laser Position icons illustate the settings being used by 
the software.  
 When clicking on a NORMal data point in the table, Target Orientation displays an N.  
 When clicking on an INverted data point, Target Orientation displays an I. 
 
 
 
 
 
 
 
 
 
Taking Data in Step 4 

 
1. Select the Auto Step method to use in the Auto Step box at the bottom of the screen. 
2. Insert the target/adapter into the first bore.  Click Record or press the spacebar to record the data 

point. 
3. Move target/adapter into the second bore and repeat Step 2 to record data. 
4. Continue until all the data has been recorded. 

Note:  To retake a data point, move the target to the desired bore location and click on the matching 
data point in the table.  Click Record or press the spacebar to re-record the data.  A popup window 
displays, asking for confirmation before overwriting the data for that point.    
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Step 5: Results 
 

 
 
Figure 18 – Bore Plot 
 
Figure 18 shows the final results of a bore plot. The top plot shows the Side View/Vertical axis data view 
and the bottom plot shows the Top View/Horizontal axis data. The red dotted line between points 
indicates that the difference between the two points is outside of the Bore-to-Bore tolerance. The solid 
blue line indicates the difference between the two points is within Bore-to-Bore tolerance. The black 
dashed line is the Best-Fit line for the data.   
 
 
The Plot Reference can be changed to reflect the data as follows:   
 

Best Fit – Shows the misalignment of the bores relative to the Best-Fit line rather than to the laser 
beam. To calculate the Best-Fit line, a least-squares, best-fit algorithm is used to find a line that “best 
fits” the raw data. It is especially useful because it removes any excess error in the data from the laser 
beam not being perfectly aligned to the end bores.  It also makes the laser setup faster since the laser 
beam does not have to be exactly centered in the bore to get accurate straightness measurements. 
When Best Fit is selected as a reference, the data is rectified to be relative to the Best-Fit Line (the 
Best-Fit line becomes the X axis) and the data is plotted relative to the Best-Fit Line (the X axis 
becomes the Best-Fit line). Any data points outside the gray area are out of overall tolerance relative 
to the Best-Fit line. 
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Laser – Shows the misalignment of the bores relative to the laser beam. A dashed black line indicates the 
Best-Fit line. When Laser is selected as a reference, the Overall Tolerance is always displayed +/- around 
zero as a gray shaded area. Any data points outside the gray area indicate that the data set is out of 
tolerance relative to the laser buck-in. 
 
Bores – Shows the misalignment of the bores relative to the selected bore 
numbers. This view makes the designated bore numbers the zero point and 
plots the positions of the remaining bores in relation to selected bore 
numbers. It also shows the Best-Fit Line of how much overall slope there is 
in the bore data relative to the selected bores. When Bores is selected as a 
reference, it rectifies the data to use the two bores chosen as the reference.  
The tolerance band stays around the X axis and any data points outside the 
gray area are out of overall tolerance relative to the bores selected. 
 
End Bores – Shows the misalignment of the bores relative to the end 
bores. This view makes the end bores the zero point, and plots the positions 
of the remaining bores in relation to the end bores. It also shows the Best-
Fit Line of how much overall slope there is in the bore data relative to the 
end bores.  
  
Show Features 
To show or hide a descriptive line on the plot, either check or uncheck the 
appropriate box. 
 

Best Fit Line – The Best Fit line is shown on the plot as a dashed black line. 
Click on the check box to toggle the Best-Fit line on/off.  

 
Red Dotted Line – A red dotted line indicates out of Bore-to-Bore tolerance. 
This should not be affected by the selected reference.  
 
Tol. Band – Click to toggle the Overall Tolerance Bands ON or OFF.  

 
 
Hover the mouse cursor 
over any data point to 
view the data for that 
point. A red square 
displays on the graph to 
indicate which point is 
selected and the 
cumulative distance to 
the data point/bore 
displays in the lower 
right corner of the plot 
area.  
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Other Features of the Bore Plot Screen 
 
AutoScale/Zoom  
To increase or decrease the scale of a specific plot window, hold the cursor over the 
area, hold left mouse button down and draw a box of the area you want to zoom.  
 
Undo Zoom  
Click Undo Zoom, to remove the zoomed in area. This is useful when there are 
more than15 bores. 
 
Laser Right/Left – To change the orientation of the laser beam on the screen to 
reflect the physical setup, select Laser Right/Left. This flips the data back and forth 
to reflect the orientation.  
 
View Data 
Click to view the recorded data and analysis that will be printed in the report. 
 

 
 



 

 45  

Generating a Report 
 
Click Print Report to print the report to a selected 
printer (see Figure 19).  
 
 
A report may also be saved as a .pdf file, however it 
is necessary to have software such as Adobe Acrobat 
installed on your computer in order to generate this 
type of file.  Click Print Report and select your .pdf 
generating software as the printer name. You will be 
asked to specify a file name for the report (see Figure 
20).  
 
 
 
 

Figure 19 – Printing a report to a printer 
 
 

 
Figure 20 – Saving a report as a .pdf file 
 
 

The following page shows a sample 4-page report generated by the Bore9 software. 
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Exporting Alignment Data to Excel Spreadsheets 
 

To export alignment data to an Excel spreadsheet for further analysis, do the following: 
 
1. Locate the Project Folder where your data is saved.  

Note:  When data is saved, a project folder with the name you entered is automatically created. For 
example, if you save a project named Test, a folder is created called Test that is located in My 
Documents/Bore Alignment Application/Projects.  This folder includes several files as well as the 
alignment data for the saved file.  
 

2. Open the folder and locate the file with the same name as the folder name, followed by RecordData. 
For example, for the Test project name, the Excel data filename will be test.recordData.csv. Also 
created is a file called (projectname).results.csv file, which contains additional data not provided in 
the (projectname).recordData.csv file.  

 

 
 
3. Assuming you have Microsoft Excel installed, double-click the file name. This automatically opens 

Excel and displays the data.  
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Where: 
 
Distance = distance between each set of bores. 
Normal VC = the Vertical-axis misalignment data relative to the reference points chosen (Best Fit, Laser, 
Bores, End Bores). 
Normal HC = the Horizontal-axis misalignment data relative to the reference points chosen (Best Fit, 
Laser, Bores, End Bores). 
Ref. Target VC = the Vertical-axis misalignment data of the reference target taken at the same time as the 
bore misalignment data. 
Ref. Target HC = the Horizontal-axis misalignment data of the reference target taken at the same time as 
the bore misalignment data. 
Inverted VC = the inverted Vertical-axis misalignment data (if selected in Preferences). 
Inverted HC = the inverted Horizontal-axis misalignment data (if selected in Preferences). 
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Appendix A - The NORMIN Procedure 
 
The NORMIN method was 
developed by Hamar Laser 
Instruments as a way of 
compensating for laser or target 
mounting errors in bore or spindle 
work. The word is a contraction of 
“NORMal-INverted,” which briefly 
describes the method.  It is quite 
similar to the four clock readings 
taken with dial indicators, but uses a 
laser and a target instead. The 
NORMIN method is used in 
conjunction with simple fixtures and 
targets that allow inexpensive, 
precision measurement. The 
target/fixture is set in the bore or 
spindle in the NORMal position 
(cable down) and the readings are 
recorded. Then the target/fixture is 
rotated 180 degrees to the INverted 
(cable up) position, and a second set 
of readings is obtained. The two sets 
of readings cancel out centering 
errors and provide a very accurate 
result. 
 
There are three centers involved in 
bore alignments: the True Bore 
Center, the Target Center, and the 
Laser Reference Centerline. If 
mounting fixtures were perfect, the Target Center would be located at the True Bore Center, and if 
perfectly aligned, the True Bore Center would be located at the laser beam center. In reality, however, 
they seldom line up. An example of the three centers with respect to one another is shown in Figure 21. 
 
Two relationships can be calculated from these three centers and two sets of NORMIN readings: the 
Target Sensor Concentricity Error (TSCE) and the True Bore Misalignment (TBM). The True Bore 
Misalignment (TBM) is used when it is desirable to know the true bore centerline position relative to the 
laser beam center without fixture errors. Usually, the laser beam center is where a bore center should be 
located, and the TBM shows its actual location. The Target Sensor Concentricity Error (TSCE) is used if 
the operator wants to place the laser beam center exactly in the middle of a bore. 
 
The general rule is: buck in to the TSCE and measure the TBM. 

Figure 21 -- Three centers of bore alignment
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The readout always shows the displacement 
between the Target Center and the Laser Beam 
Center. When the Target Center is not on the 
True Bore Center, the numbers and the signs 
on the readout will change when the target is 
rotated because the Target Center is moved to 
a different location in relationship to the laser 
beam.  
 
Figure 22 represents the target in the NORMal 
position, with the cable down. If each square 
represents .001", the Target Center is .002" 
higher than the Laser Beam Center (+.002") 
and is .007" to the right of the Laser Beam 
Center (+.007").  
 
 
 
 

Figure 22 – Target in the NORMal position  

 
 
 
 
Figure 23 represents the target in the INverted 
position, with the cable up. When the target is 
rotated, the signs on the readout are also rotated. 
Therefore, although the Target Center appears 
to be to the right of and lower than the Laser 
Beam Center in Figure 23, the vertical readings 
will be positive and the horizontal readings will 
be negative. When the vertical TCE is 
calculated, (NORMal+INverted divided by 2) 
the Target Center is .004" higher and .003" to 
the right of the True Bore Center in the 
NORMal position. 
 
The table below shows the calculation of the 
vertical and horizontal TSCE values. 
 
 
 

Figure 23 – Target in the INverted position 

 
 
NORMal Vertical Reading   +.002"  NORMal Horizontal Reading +.007" 
INverted Vertical Reading +.008" INverted Horizontal Reading -.001" 
Total  +.010" Total  +.006" 
Divide by 2 = Vertical TSCE +.005" Divide by 2 = Horizontal TSCE +.003" 

 
If you place the Laser Beam Center exactly on the True Bore Center with the target in the NORMal 
position, the readings will show Vertical +.005" and Horizontal +.003". 
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Appendix B – The A-910 Radio Transceiver/Hub 
 
Front Panel Features  
1. Power ON indicator and Low 

Battery indicator 
2. Internal backup battery charging 

indicator and USB LINK 
ESTABLISHED indicator 

3. TX indicator: blinks when device is 
transmitting data to the target(s) 

4. RX indicator: blinks when the 
device is receiving data from targets 
or other transceivers. 

5. System ID setting switch: set to the 
same number as the R-1307’s CH 
(Channel) number. 

 
Rear Panel Features 
 
1. Not used 
2. USB/Data I/O Port 
3. Power Switch 
4. External power supply: required 

only for computers that cannot 
provide adequate power (5V, 400 mA) 
through the USB port. 
Note: When using the USB 
Extender™ cable extension kit, plug 
the A-910-2.4 into an A/C power supply. 

5. Antenna 
 
See Appendix C for radio specification details. 
 

MODEL NUMBER PRIMARY FREQUENCY 

A-910-900 900 MHz 

A-910-2.4 2.4 GHz 

 

Figure 24 – The A-910 Radio Transceiver/Hub FRONT PANEL 

 
Figure 25 – The A-910 Radio Transceiver/Hub REAR PANEL 
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Using the R-1307 with a Local Target and the A-910 Radio 
Transceiver 
 
Setting the Target Network ID and System ID for the R-1307 Readout 
To make the unit visible to all other radio-enabled 
devices, you must set the Target Network ID and 
the System ID for the readout.  
1. Set the Local Readout/Target Network ID 

Press the MENU button until the upper display 
shows �.�(nn is also equal to the R-
1037 number) and the matching Target number 
with the current Target ID () blinking. Use 
the UP and DOWN arrow keys to set the 
Target ID.   

 
Press the MENU button again until the lower 
display shows .��with the current 
Target ID () blinking. Use the UP and 
DOWN arrow keys to set the Target ID to the 
same value as that of the upper display’s 
Target ID.  

 
2. Set the System ID (Radio Channel) 

Press the MENU button until the upper display 
shows �., with the current System ID 
() blinking. Use the UP and DOWN arrow 
keys to set the System ID. 

 
Note that nn must be set to the same number as 
the channel switch setting of the A-910 radio transceiver (see Figure 24, #5). 

 
Miscellaneous Display Messages 
  


 Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
 3 dashes.  Target detected but the laser is not on target. Check laser.


 Radio channel cannot be selected because no Radio is present or detected.  
Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  



 Indicates a problem with the connection to the Local Target’s Position Sensing Device 
(PSD). Check plugs and cable(s).             



 Target ‘’ descriptor does not contain target calibration data. 
 
See Appendix D on Page 54 for the complete R-1307 menu. 

Figure 26 -- R-1307 with Local Target and A-910 Radio Transceiver 
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Appendix C - Agency Certifications 
 
Agency Certifications for the 2.4 GHz Radio Transceiver  

 
FCC (United States of America) Certification 

 
Contains FCC ID: OUR-24XSTREAM  
The enclosed device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 
 

 RF EXPOSURE WARNING: This equipment is approved only for mobile and base station 
transmitting devices, separation distances of (i) 20 centimeters or more for antennas with gains < 
6 dBi or (ii) 2 meters or more for antennas with gains ≥ 6 dBi should be maintained between the 
antenna of this device and nearby persons during operation. To ensure compliance, operation at 
distances closer than this is not recommended 

 

IC (Industry Canada) Certification 
 

Contains Model 24XStream Radio (2.4 GHz), IC: 4214A 12008  
Complies with IC ICES-003 

 
 

 
 

Complies with ETSI.  France – France imposes restrictions on the 2.4 GHz band. Go to www.art-telecom.Fr or 
contact MaxStream for more information. Norway – Norway prohibits operation near Ny-Alesund in Svalbard. More 
information can be found at the Norway Posts and Telecommunications site (www.npt.no). 
 
Since the 2.4 GHz band is not harmonized throughout Europe, other restrictions may apply to your 
country. 
 

Technical Data: 
• OEM radio transceiver, model number: 24XStream 
• Frequency Band: 2400.0 – 2483.5 MHz 
• Modulation: Frequency Shift Keying 
• Channel Spacing: 400 kHz 
• ITU Classification: 400KF1D 
• Output Power: 100 mW EIRP max. 
• Notified Body Number: 0891 

                                                      
 The radio Transceiver contained in the A-1519/A-1520 Type II Universal Wireless Targets is manufactured by MaxStream. 
For more information pertaining exclusively to the Radio Transceiver please contact MaxStream at 1.801.765.9885 or visit their 
web site: http://www.maxstream.net 
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Appendix D – The R-1307 Menu 
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Appendix E – Using the Zigbee® Radio Utility 
 

Pre-installing the Common USB Port Driver (A-910-2.4ZB) 
 
This driver is required for the A-910-2.4ZB Transceiver and to communicate with targets via the 
computer’s USB port. The driver creates a virtual COM Port that is recognized by the applications as a 
standard serial port. 
 
Note: You must pre-install this driver prior to connecting the device(s) to the computer through the USB 
port.  
 
Installing the Driver 
 
1. Insert the A-910-2.4ZB Radio Programmer CD in the CD ROM drive. 
2. Select My Computer, locate the CD ROM icon and click to open it.  
3. Select the USB Drivers folder. 
4. Select the correct Operating System installed on your computer (Windows 2000, Windows XP, etc.) 

and open the folder. 
5. Locate the CP210x_VCP icon and click to initiate the installation process. The Install Driver 

dialog box displays. 
6. Click Browse to select an installation folder different from the default folder (optional). 
7. Click Install to continue. Once the installation is complete, the Installation Successful message 

displays (see Figure 27).  
 

 
 
Figure 27 - USB Common Driver Install 

 

Installing the A-910 Utility Software 
 
1. Insert the A-910-2.4ZB Radio Programmer CD in the CD ROM drive. 
2. Select My Computer, locate the CD ROM icon and click to open it. 
3. Locate the Setup icon and click to initiate the installation process.  Click NEXT to continue. 
4. Click Browse to select an installation folder different from the default folder (optional).  
5. Click Next to continue. Once the installation is complete, the Installation Complete message 

displays. Select Close. 
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Configuring the Hardware and Utility Settings 
 
1. Insert the A-910 ZB dongle into any unused USB Port (see Figure 28). 

The computer should automatically assign a COM port number to the 
dongle.  

2. Start the A-910 Utility Software. The software should display the COM 
port assigned to the Zigbee Dongle (see Figure 29). If the utility does 
not automatically detect the COM port, it must be manually selected 
(see Manually Selecting a COM Port on Page 57). 

3. The Target System ID or R-1307 CH (channel) is the number 
associated with the A-1519/1520 targets or R-1307 Readout. If using 
both the A-1519/1520 targets and an R-1307 
Readout, both need to be set to the same system 
ID and channel (see Figure 30).  

 
  

 
 
 
 
 
 
 

Figure 29 – A-910 Utility showing the COM Port, System ID and Channel settings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 30 – System ID Setup 

Figure 28 – A-910 Zigbee Dongle 
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Manually Selecting the COM Port 
 
The A-910 Utility should automatically detect the COM 
Port upon startup. If not, use the following steps to locate 
the correct COM Port. 
 
Windows XP 
 
1. Right-click My Computer.  
2. Click Properties and then select the Hardware tab.  
3. Click Device Manager. 
 
Windows 7 
 
1. Click the Start button and select Control Panel. 
2. Click the System icon. 
3. In the System window, click on the Device Manager 

link located under the System heading. 
4. In Device Manager, scroll down to Ports. Expand the 

listings under Ports to reveal all the ports installed.  
5. Locate SILICON LABS CP210x USB to UART 

Bridge (COM x) (see Figure 31). 
6. Note the COM Port listed and select that COM Port 

in the A-910 Zigbee Utility software using the drop-
down arrow (see Figure 30).  

 

Figure 31 -- Device Manager showing COM Port for A-910 
Dongle 
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Setting the Target System ID and Target Network ID 
 
The System ID is a Radio Network Address that is used by the Radio Communications Protocol to filter 
unwanted data from other radio transceivers and targets using a different address. Only targets and radio 
transceivers that are set to a matching System ID can communicate with each other. 
 
Because no two targets with the same System ID can transmit simultaneously, it is necessary for each 
target to be programmed to respond only when it is being addressed. The Target Network ID is the target 
address on the communications network. Under Host (computer) control, the radio transceiver transmits a 
message called a polling request that contains the Target Network ID of one specific target. All targets 
receive all polling requests, but only the target with a Network ID matching the ID contained in the 
polling message will reply (Transmit Data to the Host). 
 
There are three rotary DIP switches located on the 
right side of the target, shown in Figure 32: 
 
 The uppermost switch sets the System ID. 
 The two lower switches are used to set the 

target network ID. 
 
Setting the System ID 
 
Note: Before selecting a System ID, ensure that it is 
not already in use by another system within the radio 
coverage area. 
 
Using a small screwdriver, rotate Switch 1 to align 
the arrowhead with the System ID number (0-9). 
Figure 32 shows the System ID switch set to 1. 

 
 
 
 
 

Figure 32 – Unitarget ID Switch set to1 
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Setting the Target Network ID and System ID for the R-1307 
Readout 
 
To make the unit visible to all other radio-
enabled devices, you must set the Target 
Network ID and the System ID for the readout.  
1. Set the Local Readout/Target Network 

ID 
Press the MENU button until the upper 
display shows (nn is also equal to 
the R-1307 number) and the matching 
target number with the current target ID  
() blinking. Use the UP and DOWN 
arrow keys to set the Target ID.   
 
Press the MENU button again until the 
lower display shows , with the 
current target ID () blinking. Use the UP 
and DOWN arrow keys to set the Target ID 
to the same value as that of the upper 
display’s Target ID.  
 

2. Set the System ID (Radio Channel) 
Press the MENU button until the upper 
display shows , with the current 
System ID () blinking. Use the UP and 
DOWN arrow keys to set the System ID. 
Note that nn must be set to the same 
number as the channel switch setting of the 
A-910 radio transceiver (see Figure 33).  
 

Miscellaneous Display Messages 
 



 Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
  3 dashes.  Target detected but the laser is not on target. Check laser.


 Radio channel cannot be selected because no Radio is present or detected.  
Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  



 Indicates a problem with the connection to the Cabled (Local) Target’s Position Sensing 
Device (PSD). Check plugs and cable(s).             



 Target ‘’ descriptor does not contain target calibration data. 

Figure 33– R-1307 with Cabled (Local) Target and A-910 Radio 
Transceiver 
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Appendix F – Using Discontinued Computer Interfaces 
 

Connecting to the R-355D Computer Interface (Four-Axis 
Operation) 
 
1. Plug the target or targets directly into Port A or Port B of the R-355D Interface. 

Port A is assigned either Channel 1 or Channel 2 in the software setup. Port B is assigned either 
Channel 3 or Channel 4. 

2. Continue with Steps 4 and 5 on Page 62. 
 

Connecting to the R-355D 
Computer Interface (Two-
Axis Operation) 

 
1. Plug the T-237C Target Adapter 

Cable into Port A of the R-355D 
Interface 
Two adapter cables may be used, 
(one on Port A and one on Port B) 
enabling the use of up to four 
targets. The locations of ports and 
switches on the R-355D Interface are 
shown in Figure 36.  

2. Plug the target into the T-237C 
Target Adapter Cable 
Plug the target cable into one of the 
leads from the Target Adapter 
Cable. Each lead has a tag attached 
with either the numbers 1/3 or 2/4 
(see Figure 34). Cables plugged 
into Port A are assigned either Channel 1 or 2 in the software setup, depending on the lead to which 
the target cable is connected. Cables plugged into Port B are assigned either Channel 3 or 4 in the 
software setup, depending on the lead to which the target cable is connected. See Figure 35 for a 
connection diagram. Note the Port designation for use in the software setup.  

3. Continue with Steps 4 and 5 on Page 62. 
 

 

Figure 34 – R-355D Computer Interface showing Target Adapter Cable 
with lead tags 
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Connecting to the R-355D Computer Interface (One-Axis 
Operation) 
 
If you’re using a target that is compatible with a scanning laser, the procedure is the same as that for two-
axis operation except that a T-251 Target Scanner Preamp must be connected between each target and the 
T-237 Target Adapter (see Figure 35). 
 
 

 
 
  
 Figure 35 – Connecting to the R-355D Computer Interface 
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4. Connect the R-355D Interface to the computer.  

Connect the interface to the computer serial port using the special small ribbon cable provided. The 
connector for the cable is located on the back of the R-355D Interface (see Figure 36). 

 
1. Reset Button* 
2. Power Pushbutton 
3. Fuse 
4. Power Cord Receptacle 
5. Port A (Target Port) 
6. Port B (Target Port) 
7. Interface to Computer Serial Port 
 
 
 
 
 
 

Figure 36 – R-355D Computer Interface, Rear View 

 
 
5. Turn on the R-355D Interface and the computer.  

Connect the power cord to the interface and press the Power pushbutton. Turn on the computer. 
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Appendix G – Converting X-Y Coordinates to Polar 
Coordinates in Alignment Reports 
 

 
Figure 37 – Corner position coordinates 

 
Figure 37 illustrates the corner position coordinates, as if the laser 
beam was located at the four respective corners. Also shown is an 
example of a laser beam located in the upper right quadrant of the 
PSD. The beam rotation angle is displayed in standard polar 
coordinates, as shown in Figure 38 (zero degrees at three o’clock 
and counter-clockwise rotation). 
 
Note that Y = Vertical Position and X = Horizontal Position. 
Hamar lasers position readings are not in Cartesian coordinates 
(i.e. above center positive, below center negative, right of center 
positive, left of center negative). For that reason, the signs of both 
the X and Y position values used in the ATAN2 function must be 
inverted.   

Ɵ (the beam rotation angle) is calculated as follows:  
1Ɵ (radian) = ATAN2 (-1*X, -1*Y) or 
Ɵ (radian) = ATAN2 (-1*(-.3), -1* (-.2)) = 0.588 
2Ɵ (degrees) = DEGREES (.588) = 36.690.  
Finally, convert the angle to all positive values: If Ɵ (degrees) < 0, add 360 
R (radius) = SQRT(X2 + Y2) = 3.6056 
 

                                                      
1 In Excel: In MS Visual Studio, use Ɵ (radian) =  Math.ATAN2 (-1*Y, -1*X) 
2 In Excel: To manually convert radians to degrees, multiply radians by 57.29577951308232 (180/ Π). 

Figure 38 – Normal Polar Chart Orientation 


